CDOT Workflow MS 12 Accessing Aerial Imagery Files

Workflow MS 12- Accessing Aerial Imagery Files

This document guides you through the process of locating and downloading aerial imagery
stored on CDOT servers.

Please Note: This workflow has been updated for use with ORD, however, we have included
steps for MicroStation SS4/SS10 as well, to cover the minor differences.

In order to download the correct image files for a project, the names of the image tiles must first
be determined. Both Denver Area (DRAPP) and Statewide (NAIP) image tiles can be identified
using the Imagery Tile Viewer web application.

1. You will need to create an account in GeoHub in order to access the Imagery Tile Viewer
web application (as well as to access all future GeoHub applications). Please follow the
instructions HERE to create your account (must be on the CDOT network or VPN)

2. Once your GeoHub account has been created, you can open the Imagery Tile Viewer
HERE

3. The Imagery Tile Viewer will open as shown below:

This web application can be used to identify and download aerial
imagery tiles.

Click the About button o in the upper right corner of the map for
detailed instructions.

B Do not show this splash screen again.

4. Click the OK button to close the welcome window.
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5. The navigation tools in the upper left corner of the map area allow you to zoom in/out.
The Home button will zoom you to the statewide extent. Scrolling the mouse wheel will

also allow you to zoom in and out. Click and hold the left mouse button down to pan
around the map.

g

Imagery Tile Viewer

Find address or place ‘ Q ]*

53E126a

6. Click the Layers List button to display the available data layers.

Imagery Tile Viewer

7. Toturn on a layer in the map area, check the box to the left of the desired layer (i.e. DRAPP
2020). If a layer is grayed out, you need to zoom in to be able to see that layer.

Layer List A X
Layers Q=
’

» D State Plane Zones
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8. Click the Legend button to see the symbology for the layers that are enabled (checked
on) in the Layers list.

Milepoints

Highways

DRAPP 2020 (Denver Metro)

9. Inthe map area, Left Click on a tile grid to select the tile (it will highlight) in order to view its
attributes:
e Type of imagery (i.e. DRAPP 2014 TIF)
¢ Imagery Directory for that imagery type (i.e.
\\public\Aerials\Aerials_2020\Orthoimagery)
e Imagery Tile name (i.e. N1W133)

Note: Other features such as Highways can also be selected to view their attributes.

e | Imagery Directory:
7 \\publiciAerials\Aerials_2020\0Orthoimageryl
E126,, |

. | Image:
“Cal s3E126d
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10. Select the imagery directory location in the text box by quickly clicking three times on it until
the entire directory is highlighted. Then Right Click and choose Copy (or hit Ctrl-C on your
keyboard).

et

\ B
“ ”3512@,_
% _}8'5 1 Image:

- “asil S3E126d

| Zoomto wee

11. Open a windows file explorer window by clicking the folder icon in your system tray.

H L Type here to search

12. Paste the copied text into the address bar by Right Clicking in the address bar and then
choosing Paste (or Ctrl-V on your keyboard). Then hit the Enter key and you should see the
available sub folders.

| & < | Orthoimagery = [m]
ey [T
[ % Cut “7) New item ~ a Open + Select all
» B 0O X . g Ee
Copy path 1] Easy access ~ — Edit Select none
Pinto Quick Caopy Paste Move Copy Delete Rename  New Praperties .
s ¥ Pasteshorteut | ¢ 35 = folder = History " Invert selection
Lijabconil, = L Open Select
<« 20 ‘ \\public\Aerials\Aerials_2020\Orthoimage! vl 0 Search Orthoimagery
- Google Drive (GJ + Name Date modified Type Size
Cleanap 3in_Central File folder
QAQC 6in_Central File folder
SB267_Pavement_BridgeCondition 12in_Central File folder

Updates-Spring2021
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13. Back in the Imagery Tile Viewer, highlight the entire image tile name in the text box by

clicking twice on it until the entire name is highlighted. Then Right Click and Copy (or hit

Ctrl-C on your keyboard).

.

*elnds

DRAPP 2020

o

47" | Imagery Directory:

o
e
8{'&3526“_

 \\public\Aerials\Aerials_2020\0rthoimagery

1 Zoomto e

14. In the same windows file explorer pane from earlier steps, paste the copied text into the
search bar. Hit Enter to initiate the search for the image.

< | Orthoimagery

1 cut 17 New item + 2 Open § selectall
# B X ; J Ee
% Copy path £ Easy access ~ — Edit Select none
Pinto Quick Copy Paste Move Copy  Delete Rename  New Properties .
access 7 Pasteshorteut | to- 1o folder - History Invert selection
Clipboard Organize Hew Open Select
« v o » Network » public » Aerials » Aerials 2020 > Orthoimagery v o O S3E126d
« Google Drive (G:) A~ Name Date modified
Cleanup 3in_Central
Qaac gin_Central
SB267_Pavement_BridgeCondition 12in_Central

Updates-Spring2021

15. Any files matching the search should display in the window as shown below. Select all found

files and Right Click and Copy (or hit Ctrl-C on your keyboard).

8| %

i Swae e

[T %okind-
e

Search Tools
Search

Current folder

W e |
= [ ansubfolders ] size~
This eMEC— Date
BC 4 Searchagainin*  modified= | Other properties =
Location Refine
« © 4 W > SearchResults in Orthoimagery

« Google Drive (G
Cleanup
oaQc
5B267_Pavement_BridgeCondition
Updates-Spring2021

@ OneDrive

= This PC
¥ 3D Objects
B Desktop
= Documents
¥ Downloads
D Musie
& Pictures
B videos
45 Windows (C)
Gaogle Drive (G:)
dtddats (\\public) (N:)
dtdimagery (\public) ()
_ROWFiles_processing (\\public\dtdimagenAROWFiles) (¥:)
DTDimages (\110.35.11.235) (Z)

P O O ]

Colorado Department of Transportation

€ Recent searches ~
[£] Advanced optians ~
[ save search

Options

$3E126d - Search Results in Orthoimagery

X

Openfile  Close
location  search

v o

O S3E126d

S3E126d.tif

1 S3E126dtfw

L \\public\Aerials\Aerials_2021

Type: TIF File
Open
Create a new video

0 Edit with Photos

Set as desktop background
Print

Rotate right
Rotate left

Cast to Device >

Convert to Adobe PDF

Combine files in Acrobat...

BT

Edit with Notepad=+
= Share

E snagit >
& WinZip >

Always available offline

Send to >

Cut

| Copy |

i
Create shortcut

Type
File folder

File folder

File folder

Date taken: 12/3/2020 10:45 AM
Size: 425 MB

Date modified: 12/1/2020 10:33 PM
Size: 41 bytes
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16. Open a new windows explorer pane and navigate to the desired location on your local
machine, then Right Click in the windows explorer pane and choose Paste (or Ctrl-V

on your keyboard).
17. Repeat above steps for any other files needed.
Tips/Tricks:
e Occasionally when you access the Imagery Tile Viewer, you may be prompted

to sign in again. Please click the blue Enterprise Login button, which should
sign you in automatically.

Enterprise login

Colorado Department of Transporntation (CDOT)

¢ You can change the base map if desired by clicking the Basemap Gallery button
and choosing the desired basemap.
ImaeryTileViewer

Azunite

SIEH6C S3IE116d | S3ENTE | & S3E

& ° St

Light Gray Canvas

Silver
Heights

id
o,

¢ If you have multiple layers turned on and you try to click on a grid to get the
image tile attributes, be aware that you might have multiple features selected. If
you see 1 of “X” in the upper left corner of the info box, you can click the arrow to
the right to display the other selected feature’s attributes.

3E 1260 S3E127a AS3E]

. S3E1250
o)

DRAPP 2014 TIF

magery Dir
Virocaerials\aerials_2014\uncompressed

Zoom to Gt Drectsons
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¢ Some help content is available by clicking the Help button.

Mational
Grasslands

This web application can be used to identfy end download
DRAPP and NAIP aerial imagery tiles.

1.Zoom in on the map or use the Find Address box to
locate your eree of intersst.

2. Nextturn on the desired imagery layer in the Layers

widi et

e Be aware that each NAIP TIFF will have one of two projections (UTM 13N
NAD83 or UTM 12N NAD83) depending on where in the state it is located. This
can be determined in the file name (712 or 13). The following western Colorado
counties are UTM12N NAD83: Delta, Dolores, Garfield, La Plata, Mesa, Moffat,
Montezuma, Montrose, Ouray, Rio Blanco and San Miguel. The rest are UTM
13N NAD&83.
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Attaching Image Files To A DGN File

Accessing Aerial Imagery Files

The following steps describe how to attach image files copied from the server to a DGN file and
apply the proper geographic coordinate system associated with the images to the DGN file.

Note: Whether you are using MicroStation SS4/SS10 or OpenRoads Designer (ORD) and are
working locally or on the ProjectWise Cloud, the following steps are the same, regardless of the
application.

1. Create a new file using the 2D seed file.
ﬂ Mew - C:AProjects\CDOT Imagery Workflow!, X
Savein: | * CDOT Imagery Workflow v| @ ?‘ s [~ :[3 &
ﬁ' MName - Date modified Type Size
s " MS12 Accessing Aerial Imagery Files Workfl.,  7/29/2021 9:25 AM File folder
Quickaccess =M ges Example.dgn 7/29/2021 8:11 AM DGN File 209 KB
! ﬂlmages.dgn /2972021 8:56 AM DGM File &0 KB
Desktop
= |
Libraries
This PC
Net-\-c\rork
File name: | PCHE Specialy-Group Imagery] v|
Save as type: MicraStation DGN Files (" dan) e Cancel
Seed: |lesigner CE Configuration“Organization-Civil\C DOT_Standards"-.Sei:l'-ED-Seed_C DOT.d4 Browse

The next steps are used to assign the imagery’s geographic coordinate system to the DGN file.

2. From the Drawing workflow > Utilities tab > Geographic section, select Geographic System tool.

Elpawing o HER«-+» 222 @& - C:\Projects\CDOT Imagery Workflow\JPC#2_Specialty-Group_imagery.dgn [2D - V8 DGN] - OpenRoads Desi

File Home View Annotate Attach Analyze Curves Constraints Drawing Aids Content Help cpor
| & MDL Applications v r| [z » Play ® Record [ 7 whe = P s ©
% ) (® Close Tool Boxes ‘ '—ﬁ (O] (%) E . ! cﬂ: L 8 % ‘-' = & e
1 B(V;.I’aer:;;lns ® Connect to Browser Display Convert Capture B 9 ViewControl | M;jr?ager Commit Initialize Signatures Slgg;ltlura c.;;;ﬁ.ar;:te g6 [ | USsuneyinch
Utilities Image Macros ] Design History ] Security Geographic

-Z%(— .:,.’_ X [ 10351041627 Y 5370342326
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The same tool is found in the MicroStation SS series as shown below:

agery Workflow\JPC##_Specialty-Group_lmagery554.dgn [2D - V& DGM] - Power InRoads V&i (SELECTse

sttings | Tools [, fitributes luation Drainage Drafting Quantties Power InRoads
v Primary vénv@ﬂv@ﬂv v
v Standard
i 00 }
b oo E-[Il:_ll fz“i.i' Activate Map
L= Default
Product Add-Ins v ,;"q 3 W ¢ 2 G
Task: a - o ) G| .,
PN s WP Y ﬂ .t N
Dete.n. g Sy »
Dimensions 3
N T
v | Geographic P 23/ 1 Select Geographic Coordinate System
roups £ Global Posttioning System
Levels ¥ & 3 Expoit Google Earth (KML) File
¥ Manipulate * e 4 Capture Google Earth Image
Measure P& 5 Define Placemark Monument
Mesh » [‘_‘P & Synchronize Google Earth View
Multifines Y% 7 Folow Google Earth View
Parametrics } iz 8 Google Earth Settings
Patteming » @9 9 Play Camera Animation in Google Earth
Point Cloud »|4] 0 Open Location in Google Maps
Project Navigation DI: T T
Properties
Raster 3
= Redline 3
Reference ¥ | Geographic
k v Security _
Il. I1~ &5 0l - S N e
Selection \=3 #\,gl‘@gr_‘lgr_ﬁ'k_:lglﬂ']
Ot e dimr o

Note: The following steps apply to both ORD and the MicroStation SS series.

3. Inthe Geographic Coordinate System tool settings box, select the From Library icon.

4. Inthe Select Geographic Coordinate System dialog box, expand Favorites and
Colorado Projected. Select the appropriate coordinate system for your image file. In
this example, the image is in the Colorado Central Zone, so CO83-CF is used as shown
below:

54 Select Geographic Coordinate System

Library ISEamh
e

-/ Favorites

(1. 1 Colorado - Projected {northing, easting N )

%27 COL - NAD2/ Colorado State Flane, Central Zone(502), US Foot

O-N - NAD27 Colerado State Plane. Noth Zone(501), US Foot
LS 007 Colocade Giote PL ih N1HFM

083CF - NADB3 Calorado State Plane, Central Zane, US Foot

8 I
< FoilEx
Current Geographic Coordinate System

MName:  <None>

= Sorads Siate Tlane. Towh Zore, U5 o
083 SF - NADE3 Colorado State Plane, South Zene, US Fost
083 - NAD83 Colorado State Plane, Certral Zone, Meter
083N - NADE3 Colorado State Plane, North Zane, Meter
{2} C083-S - NADS3 Colorado State Plane, South Zone, Meter
083/2011CF - NSRS11(NAD83/2011) Colorade, Central Zane, US Fact
1 CDOT-Projects

Library

Description:

Source:
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NAIP TIFF will have one of two projections (UTM 13N NAD83 or UTM 12N NAD83)
depending on where in the state it is located. This can be determined in the file name
(12 or 13). The following western Colorado counties are UTM12N NAD83: Delta,
Dolores, Garfield, La Plata, Mesa, Moffat, Montezuma, Montrose, Ouray, Rio Blanco and

San Miguel. The rest are UTM 13N NAD83.

These can be found using the search as shown below:

&1 select Geographic Coordinate System — O X
Library I Search I
Search Text JUTM 13N NADE3
(®) Any Wword () Al \Words
Kex Name Descrntion | It -
[ EPSG:26913 NADE3 / UTM zane 13N Meter
SR KL MEDdCone 7 M zone 130 Meter
EP5G:3743 NADBIHARN) / UTM zone 13N Meter
UTME3-HA-13 Higher Accuracy UTM with NADB3 datum, Zone 13, Meter METER
UTM33-13 UTM with NAD83 datum, Zone 13, Meter; Central Meridian 105d W METER
i e+t e P
Add To Favarites Properties. .
0K Cancel

Note: The coordinate systems for both the DRAPP and NAIP images can be found in
both the Colorado - Projected and the DRAPP & NAIP — Coordinate Systems for

CDOT Imagery folders.

Once the coordinate system file has been assigned, it is shown in the Geographic Coordinate

System tool settings box.

ﬂ Geographic Coordinate Systern —
EQ L PP IEN

Current Geographic Coordinate System
Mame: CO83-CF

Description:  MADE3 Colorade State Plane, Central Zone
Source:  Calculated from CO823-C by Mentor Softwi

The new dgn file is now ready to attach the imagery file.

Colorado Department of Transportation
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5. Set the Level for the DGN file to DRAFT_Image. The illustration below show how to set

the level in ORD. Be sure the workflow is set to Drawing and use the Home tab.

g4 Drawing - = HE b T=2108& -
Home View Annotate Attach Analyze Curves Constraints Litilities Drawit
& Mone ™ | Default E ﬁ |r'7'.l I@ ’ ' ’ k b .

| * @

— Show * =

]
Element -4

N - pss] - — =
E = =20 == | evel Filter: (none) F‘% v ? T | Selection B T
Attri P ry Selectio
_:%:_ ;" X 35319077 DRAFT_Corridor-Template Dr - (5 B -
..... . DRAFT_Corridor-Transition - | & 177}
Properties ;
r'::;l : = DRAFT_Corridor-Transition - 1 (4 O
,57 DEAET Coridor Teapeition - | [
é{i I DRAFT Image b |
4 UEAF_Information-Mo Flot ) L
@, DRAFT Matchlines = |

The illustration below shows how to set the level in the MicroStation SS series.
M4 C\Projects\CDOT Imagery Workflow\JPC#% _Specialty-Group_|magerySSd.dgn [2D - \

File Edit Eement Settings Tools Survey Surface Geometry Evaluation Drainag

# - |[pefaut -1l ~-1=0 ~
| DRAFT_CO-White
O iRl
IDraﬂ_Image
OB T rgaen
W DRAFT_INFO_No-Plet
> cin DRAFT_INROADS_Notes
DRAFT_LC-Center_WT-0
E £ DRAFT_LCCenter WT-2
1% |2} DRAFT_LCContinuous_WT-0
2 2.4 DRAFT_LC-Continuous_WT-3
- DRAFT_LC-Dashed_WT-0
% mnaly DRAFT_LC-Dashed_WT-3
DRAFT_LC-Divide_WT-D
S8 Gene|DRAFT_LC-Divide_WT-3
— |DRAFT_LC-Dotted_WT-D
- HOMZ{nRART | C-Dotted_WT-3
| DRAFT_LC-Hidden_WT-0
BB Vertit et C ridden W

=]
4

o
>

OOOODOOOoODOoOooEORO ]DE{’!’"

A A YL AN N
CO00 0000000000 do

6. Once you have set the level to DRAFT_Image, open the Raster Manager as shown
below.

For ORD, From the Drawing workflow > Home tab > Primary section > Attach Tools >Raster
Manager:

&4 [ Drawing 1= H k! s T2 0@ - C:\Projects\CDOT I
File View Annotate Attach Analyze Curves Constraints Ltilities Drawing Aids Content

= e ETE 2

None ~ ||DRAFT_Image * o [ (4

= mag Q o /Y
o - = - || = - v || A » | Explorer| Element § Ence Place
S0 =0 =0 @0 = 0 Selection @ Tools~ ﬁl ™ | SmartL

Attributes Selection

O Point Clouds
B View 1, CDOT De

| @ Reality Mesh
F

B e oD EBE B

Colorado Department of Transportation
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For the MicroStation SS series:

7.

8.

B4 CA\Projects\CDOT Imagery Workflow'\JPC##_Specialty-Group_lmagerySSd.dgn [20 - V8 DGN] - Power InRoads V8i (SELECTseries )
° Fle Edit Eement Settings Tools Survey Suface Geometry Evaluation Drainage Drafting Quantiies Power InRoads Tools  Ulilties Workspace Window  Subsurface

E@vlnraﬁ_\mage vl@o v|§20 v|zo viﬁo v |5 0 ~ gvgj@-Qv:gﬁv_g‘w%
EI? ? :'5‘ OH ‘1 88!&}! E ZE D§‘|v Raster Manager|

Task X
= h B View 1, CDOT Default

In the Raster Manager dialog box, Select File > Attach >Raster.

EH Raster Manager: 0 of 0 listed - X

File IEdit View Display Settings Tools Utilities

3 v i e - LH Lix
i B2 8o 549 B
tta
= =i Description B Model
Detach 5§ WMS...
Detach All E From Image Server...
Reload 5§ ECWP Image Server...
Save As.. Bing Maps...
h§ Attach Raster Grid
Export 4
Import 4

Batch Convert

TIEIEI-‘-&ISIBI?IS = @ EE T D Tran:parenc',':-

In the Attach Raster Reference dialog box, navigate to the folder containing the images. Select
only the *.tif image file, make sure Open Settings Dialog is toggled on, then click the Open

Button.
&) Attach Raster Reference 'Y
T+ I % « CDo... » MS12 Accessing Aerial Imagery Files Workflow u... v I <] S Search MS12 Accessing Aeri...
Organize = New folder = | 0
S
[ Desktop ” Mame Date Type Size Tags
P! 9
Documents M SIF110h iy IEEl KB
& Downloads I@ S2E112b.4if IF File 435,739 KB I
J& Music 1| S2E126d tw TFW File TKB
&) Pictures (24 5261264 i TIF File 435,736 KB
8 Videos
.08 (C)
File = Open Read-Only
Directory ¥ Place Interactivel
[ Open Settings Dialog
File name: | 52E112b.tif v‘ All Files (*.7) ~
e

Colorado Department of Transportation
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Note: If you are working in ProjectWise the Attach Raster Reference dialog box looks the image

below. Highlight the desired file, Left Click the Add button, then, Left Click the OK button.

|
Select
Douments
Frolder ;|_, Drandngs | & B === |
5 [
= m_3910557_ne_13_(60_20190922 44
e — |
# m_190557_ne_13 06020190822 44, avr
# ] m_3910557_ne_13_060 20190922 txt v
€ >
Application: Al Applcations w
Exberson: Al documerts |
[
Aadd S=mrue
L,
Selected Documents, chedk mark oy
hame
=] m_3910557_ne_t3.050_ 20190822 44

< >

=

9. This displays the Raster Attachment Options dialog box. For DRAPP images in the Geometry

tab, select Sister File.

| & Raster Attachment Options - [m] x|
o5
B C:\Projects\CDOT Imagery Worlkflow'\MS12 Accessing Aerial Imagery Files Workflow update\S2E112b tif
|
| Action ~ General A
|| Placeinieractively  No Level |
! Color |
Line Style
‘Weight
Class
Pricrity
Image ~ Color -~
Logical Name Tint [ [255.255.255]
{ Description Contrast 0
| Brightness 0
Invert Do Not Invert Display
Transparency Hide
Display Print v Extended v
=]

Colorado Department of Transportation

13



CDOT Workflow MS 12 Accessing Aerial Imagery Files

For NAIP images, select Raster Header for the GeoPriority. Set the Inherit GeoCS from Model to
Not Inherited.

£ Raster Attachment Options - m] X

[ER.: ] Attachmen:
*-fH C:\Projects\CDOT Imagery Workflow\NAIP-20210805T142443Z-00T\NAIP\m_3810557_ne_13_060_20150822 tf

Action -~ General -~

Place Interactively Ne Level
Coler
Line Style
Weight
Class

Image ~ Color ~
Logical Name Tint [] [255.255.255]
Description Contrast 0
Erightness 0
Invert Do Not Invert Display
Transparency Hide
Display Print v Extended ~
Snappable Snappable
Locked Unlocked
Geometry ~
Geo Priority

Inherit GeoCS from MogINot Inherited

10. Repeat steps 4 through 6 for all images to be attached.

The new image design file is now ready to be used with Project Plan files by referencing it using the
Geographic Reprojection option so that it aligns with the Project Specific Coordinate System set by the
Survey Team in the survey file deliverable for this project. More details on reprojection are explained in
workflow MS 24 Assigning Project Coordinate System.

Colorado Department of Transportation 14



	Workflow MS 12- Accessing Aerial Imagery Files
	Attaching Image Files To A DGN File


